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Лабораторная работа №1 

Работа со слоями и режимами наложения 

Цель: «завязать» шею жирафа в узел 

Задачи: 

1. Научиться работать со слоями  

2. Изучить режимы наложения. 

 

Краткие теоретические сведения 

Что такое Слой? 

Слой это основа основ растровой графики. Мы не могли бы делать 

ничего, ни в Фотошопе ни где бы то ни было, если бы элементы дизайна не 

располагались на разных слоях. Чтобы эффективно двигать объекты и менять 

дизайн, элементы должны находиться в, своего рода, 3D пространстве. Но 

откуда в двухмерной программе взяться 3D? На помощь пришли слои. 

Слои в Фотошопе можно представить как виртуальные невидимые 

поверхности. На каждой поверхности можно разместить графику. Таким 

образом, какая-то графика будет на верхнем слое, какая-то посередине, а 

какая-то на дне. 

В Фотошопе существуют разные виды слоев.  

 Обычный слой — представляет из себя ту самую виртуальную 

поверхность, о которой мы говорили выше. Это растровый слой, не 

обремененный, никакими дополнительными возможностями. Графика в виде 

пикселей может на нем быть, или не быть. Обычный слой может быть простой 

фотографией или элементом графики. 

 Слой заливки — считаю необходимым выделить слои заливки в 

отдельную группу. Эти слои представляют из себя специфические настройки, 

позволяющие заливать задний фон цветом, градиентом или текстурой 

(паттернами). Заливочные слои удобны тем, что вам предоставляются панели 

настроек, через которые удобно вносить все изменения, настраивая слой так 

как вам нужно. 

 Слой цветокоррекции (ajustiments layers)  — очень 

специфический слой. Фактически это фильтр, который меняет цвет 

нижестоящих слоев. В Фотошопе существует множество 

цветокорректирующих слоев разных видов и мы детально разберем все из них, 

в следующих частях статьи. 

 Слой с текстом — текст в Фотошопе содержится на отдельных 

слоях. Эти слои так и называются — Text Layer. По большей части если вы 

знаете, как работать с текстом в Фотошопе, то вы уже разбираетесь в тестовых 

слоях. Хотите научиться работать с текстом? Тогда вам прямая дорога в цикл 

статей Работа с текстом в Фотошопе. 

 Смарт слой — наиболее продвинутое ноу хау Фотошопа 

последних версий. Этот слой  представляет из себя защищенный обычный 

слой. Защита заключается в том, что слой помещается в специальный 

контейнер, который запрещает видоизменять графику. Этот контейнер и 

называется Смарт слоем, или умным слоем. А замочек на иконке слоя как раз 

http://hronofag.ru/2011/12/type-tool/


и означает — защитный элемент. Ну и зачем, спрашивается, нужно 

блокировать графику? Ведь смысл работы с графикой в том чтобы её менять. 

Смарт слой не блокирует графику в прямом смысле. Графика хранится 

внутри контейнера смарт слоя и с ней можно делать что угодно. Но в добавок 

к этому, смарт слой предлагает десятки дополнительных и удобных фич, вроде 

записи фильтров и возможности менять эффекты на лету, не портя графику, 

удобной работы с RAW изображениями, дополнительная маска для эффектов 

и многое многое другое. 

 3D слои — ещё одно ноу хау Фотошопа, который позволяет 

внедрять в 2D графику реальны трехмерные модели. Все благодаря 3D слоям. 

Эта тема является одной и наиболее продвинутых и сложных в фотошопе. 

Поэтому её мы каснемся отдельно, в других статьях и уроках. 

Режимы наложения 

Режимы наложения (смешивания) в Фотошоп можно использовать в 

качестве альтернативных путей для основных обработок - это когда каждый 

слой взаимодействует со всеми слоями, расположенных ниже него. Всё это 

предоставляет безграничные возможности в особенности, когда речь идёт о 

подборе правильного тона или коррекции освещения. 

Нормальные режимы наложения 

К данной категории относятся такие режимы: Normal (Нормальный) и 

Dissolve (Растворение). 

Normal (Нормальный) 

Этот режим в Фотошоп стоит по умолчанию, в результате виден только 

самый верхний слой. 

Dissolve (Растворение) 

При установлении данного режима, в эффекте появится жёсткая 

зернистость и пиксельность. С двух слоёв берутся случайные пиксели и 

используются без сглаживания. Если у слоя с режимом смешивания 

Растворение значение непрозрачности высокое, то большее количество 

пикселей будет присутствовать с верхнего слоя, и соответственно, если 

значение непрозрачности низкое, то пикселей будет больше с нижнего. 

Субтрактивные режимы наложения 

К этой категории относятся режимы, затемняющие изображение. 

Darken (Замена тёмным) 

В результате цвета делаются равномерно тёмными. Значения в цветовых 

каналах снижаются. 

Multiply (Умножение) 

При использовании этого режима, изображение становится 

выразительнее и темнее. Значения цветовых каналов верхнего и нижнего слоёв 

перемножаются. А так же: любой цвет, перемножаемый с белым даёт 

исходный цвет, перемножаемый с чёрным - даёт чёрный цвет; цвета, 

полученные в итоге, не будут ярче исходных. 

Color Burn (Затемнение основы) 



В результате использования этого режима, цвета на изображении станут 

темнее, и повысится контрастность. Белый цвет не изменит ничего и никакого 

эффекта не даст. 

Linear Burn (Линейный затемнитель) 

Изображение с таким режимом смешивания приобретёт тёмные 

оттенки. Если изображение смешивается с белым цветом, то оно не 

изменяется. Цветовые значения инвертируются, суммируются и снова 

инвертируются.  

Darker Color (Темнее) 

Цветовые оттенки на изображении станут темнее. Цветовые значения 

снижаются, но только в пределах отдельного канала. 

Аддитивные режимы наложения 

К этой категории относятся режимы смешивания, осветляющие 

изображение, и добавляющие им яркость. 

Lighten (Замена светлым) 

Цветовые оттенки на изображении делаются равномерными и светлыми. 

Цветовые значения в каналах увеличиваются. 

Screen (Экран) 

Фотография делается немного размытой и более яркой. Цветовые 

значения каналов инвертируются, перемножаются и вновь инвертируются. 

Полученные цвета никогда не будут темнее оригинальных. 

Color Dodge (Осветление основы) 

На изображении цвета станут более светлыми, а контрастность 

понизится. Чёрный цвет ничего не меняет. Исходные цветовые значения 

повышаются, а контрастность уменьшается. 

Linear Dodge (Add) (Линейный осветлитель (добавить)) 

Данный режим смешивания придаст изображению светлые оттенки 

цветов. В результате цветовые значения увеличатся. Если изображение 

смешивается с чёрным цветом, то никаких изменений не произойдёт. 

Lighter Color (Светлее) 

Цветовые оттенки на изображении приобретут более светлый оттенок. 

В результате цветовые значения увеличатся и не затронут отдельные цветовые 

каналы. 

Комплексные режимы наложения 

Из самого названия категории понятно, что режимы, находившиеся в 

ней, сделают изображение не только темнее или светлее, а будут 

воздействовать по всему диапазону. Обязательно поиграйте с этими 

режимами, в работе они полезны для добавления тонировки, резкости, 

виньетирования или текстуры. 

Overlay (Перекрытие) 

Оба слоя смешиваются вместе. Одни области будут светлее, другие 

темнее, сохраняя эти значения с нижнего слоя. Цветовые каналы принимают 

режим наложения Экран или Умножение, всё зависит от того, насколько 

основной цвет отличается от 50% серого. 

 



 

Soft Light (Мягкий свет) 

При установлении данного режима, изображение будет освещаться 

рассеянным светом. Использование белого или чёрного цвета придаёт картине 

соответственно более светлый или тёмный оттенок. Если верхний слой светлее 

50% серого, то происходит осветление, и если темнее 50% серого - происходит 

затемнение. 

Hard Light (Жёсткий свет) 

Изображение с таким режимом освещается резким светом. Цветовые 

каналы приобретают режим Экран, если цвета нижнего слоя светлее 50% 

серого и если темнее 50% серого, то Умножение. 

Linear Light (Линейный свет) 

Цвета на изображении затемнятся (burned) или осветлятся (dodged) и 

уменьшится или увеличится яркость. Яркость уменьшится, если цвета 

нижнего слоя темнее 50% серого, и увеличится, если они светлее. 

Vivid Light (Яркий свет) 

В результате цвета на изображении затемнятся (нижний слой светлее 

50% серого) или осветлятся (нижний слой темнее 50% серого), и 

контрастность соответственно уменьшится или увеличится. 

Pin Light (Точечный свет) 

Все цвета смешиваются, но некоторые из них заменяются. Если на 

верхнем слое цвет светлее 50% серого, а на нижнем темнее, чем на верхнем, 

то в этом случае цвета заменяются значениями с верхнего слоя. То же самое 

происходит и, если цвета верхнего слоя темнее 50% серого, а на нижнем 

светлее, чем на верхнем слое. 

Hard Mix (Жесткое смешение) 

Тёмные цвета делаются темнее, а яркие - ещё ярче. Режим Жёсткое 

смешение очень жёсткий. На нижнем слое контрастность максимально 

увеличивается и происходит смешивание с верхним слоем. 

Разностные режимы наложения 

Режимы наложения, относящиеся к этой категории, создают новые 

цвета, которые основаны на разнице между нижним и верхним слоями. 

Difference (Разница) 

В результате использования данного режима цветовые каналы 

изменяются и смешиваются. Тёмные значения цветов вычитаются из светлых. 

Происходит замена белых участков с верхнего слоя на инвертированные 

цветовые значения с нижнего. Тогда, как чёрные области верхнего слоя не 

изменяются. 

Exclusion (Исключение) 

В цветовых каналах происходят изменения, но с белее низким 

контрастом, чем в случае с режимом наложения Разница. 

Subtract (Вычитание) 

При использовании данного режима наложения цвета изменяются и 

смешиваются. Происходит вычитание цветов верхнего слоя из нижнего, в 

чёрных областях цветовое значение будет с нижнего слоя. 



Divide (Разделение) 

Цвета при таком режиме смешивания резко изменяются. Значения 

цветов нижнего слоя делятся на цветовые значения верхнего. 

HSL режимы наложения 

В данной категории собраны режимы, которые могут быть полезны при 

редактировании цветовых характеристик: света, насыщенности или тона. 

Hue (Цветовой тон) 

Применив этот режим, насыщенность и яркость нижнего слоя 

комбинируются с оттенками верхнего. 

Saturation (Насыщенность) 

В результате применения режима Насыщенность оттенки и яркость 

цветов нижнего слоя комбинируются с насыщенностью верхнего. 

Color (Цветность) 

Насыщенность и тон верхнего слоя комбинируются с яркостью цветов 

нижнего. Это особенно хорошо работает для градаций серого и может быть 

использовано в качестве окрашивания монохромных фото. 

Luminosity (Яркость)  

В результате применения данного режима смешивания яркость верхнего 

слоя будет комбинироваться с тоном и насыщенностью нижнего. 

 

Ход выполнения работы 

Шаг 1 

Создайте новый документ в Фотошопе (Ctrl + N) размером 550х800 

пикселей с разрешением 72 пиксель/дюйм. Вставьте в него фотографию 

пустыни. 

 
Шаг 2 

Примените к слою пустыни отражение по горизонтали (Edit → 

Transform → Flip Horizontal). Выберите инструмент Crop Tool (C) и вырежьте 

этот участок: 



 
Шаг 3 

Примените коррекцию Black & White (Image → Adjustments → Black & 

White). 

 
Шаг 4 

Создайте новый слой и выберите большую мягкую кисть. Откройте 

панель кистей (F5) и настройте всё, как показано на скриншоте. Нарисуйте 

большое пятно на правой стороне пустыни. 



 
Шаг 5 

Создайте корректирующий слой Gradient Map. 

 



 
Шаг 6 

Вставьте жирафа. 

 
Вставьте узел поверх жирафа. 



 
К слою узла добавьте маску и чёрной кистью скройте некоторые участки 

узла. 

 
Шаг 7 



Создайте для узла корректирующий слой Black & White, чтобы изменить 

его цвет. 

 

 
Шаг 8 

Создайте копию слоя жирафа и поднимите её над слоем узла. 

Установите режим наложения Multiply. Создайте обтравочную маску (Ctrl + 

Alt + G) и добавьте пиксельную маску, залитую чёрным цветом. 



Инструментами Brush Tool (B) и Polygonal Lasso Tool (L) заполните белым 

цветом отмеченные участки: 

 
На этом скриншоте видно то, что должно быть закрашено. 

 
Результат: 



 
Шаг 9 

Наложите на узел текстуру кожи. 

 
Установите режим наложения Multiply. 



 
Создайте обтравочную маску (Ctrl + Alt + G): 

 
Шаг 10 

Установите 

[url=http://alfoart.com/images/giraffe_neck_knot/giraffe_lines.abr]эту[/url] кисть 

и воспользуйтесь ей в качестве ластика. Создайте полоски на текстуре. 



 
Сотрите текстуру с выделенных участков. Там уже есть нормальная 

кожа. 

 
Шаг 11 

Нарисуйте тень на отдельном слое. 



 
Шаг 12 

Чтобы усилить тени, создайте копию узла (Ctrl + J) и поднимите её на 

самый верх панели слоёв. Примените коррекцию Black & White. 

 
Примените коррекцию Levels (Ctrl + L). 



 
Примените коррекцию Gradient Map (Image → Adjustments → Gradient 

Map). 

 



 
Шаг 13 

Установите режим наложения Multiply. На скриншоте ниже показано, 

что автор использовал корректирующий слой для градиентной заливки, но 

результат при это не изменился. 

 



Шаг 14 

Создайте копию верхнего слоя узла. Увеличьте количество чёрного 

цвета при помощи коррекции Levels (Ctrl + L): чёрный и серый ползунки 

нужно сдвинуть ближе к центру. Установите режим наложения Soft Light. 

 
Результат: 

 
Шаг 15 



Верхняя часть жирафа стала слишком тёмной и визуально тяжёлой. 

Чтобы восстановить баланс, давайте удлиним ноги. Выделите отдельные 

участки ног и скопируйте их на отдельные слои. 

 
Растяните среднюю часть при через меню Edit → Content-Aware Scale. 

 



Соедините всё, чтобы не было заметно разделения. 

 
Шаг 16 

Создайте коричневый овал на песке. Примените к нему фильтр Gaussian 

Blur (Filter → Blur → Gaussian Blur) со значением 2-3 пикселя. Расположите 

его под ногой. Такой овал нужно создать под каждой ногой. 

 
Шаг 17 

http://click01.begun.ru/click.jsp?url=J2ul8NLf3t-6mpe2yV-TFgKyq7nSbrXf*tx57c*d4gThseFNRozTvdRiPI-F1rWsWPn99zzykxbs2rR2VgXwZdKTSyhSukXKo6EBzH3IZOzHyTzZEUX0NPItSJGryUOABesbrSJVp2SaOp8wwSMYqFyAw8gIAwd4Y5zbpFNu*NBozBMMlC47Whgvt41*83lJRNH1L92-dgp-QSzqr-Fa8ipzvqJfyDmAih00Kw1YtdzdsFrdqVGqZ56HRZm4xFBgkWA4ZCZV634WT90FK1dHq1j*6Z*Vlwb2ICxx04*MSON95jqsSFsTta6GyA1jc9c9wkUPs85u7FblGJSrM7CX2DUuuOfbWgZw9P7-xodoCvCifH3zNb-d-iFRj2m3Tf2OzXOQWEkU7bbutQ1loqNDbEjjMVm7sZEqD-aC5Yto*KE7VaE03SyMKEaDSFhmWnUmgC6FJyTHKk6WjNzI*X4WwsmtFX0TKSRsCd4KRON-l0tJSbyn7AXXbYJpRU5FaHahZX-ycngse*PFoXpMOgcPN-qUkFA&eurl%5B%5D=J2ul8GZmZ2ZLCmo*dplNbDyaZJIZ6MMetmYeerd3sRJY4zy6goMN6TiOve9HURl9iS-sn5VozaZy-O*iAj5IiuuEQuI


Создайте копию всего жирафа (Ctrl + J). Выделите копию и заполните её 

коричневым цветом. Переверните коричневый силуэт (Edit → Transform → 

Flip Vertical) и опустите его под жирафа. Активируйте режим Distort (Edit → 

Transform → Distort) и измените форму тени. 

 
Шаг 18 

Для слоя тени установите режим наложения Multiply. Добавьте маску к 

слою тени. Затем активируйте быструю маску (Q) и заполните нижнюю часть 

градиентом. 



 
Выключите ежим быстрой маски (Q) и Вы получите выделение с 

мягкими краями. Примените фильтр Gaussian Blur со значением 8-12 пикселей. 

Кликните на маске слоя тени и залейте выделение чёрным цветом. Уменьшите 

непрозрачность, чтобы получить более мягкую тень. 



 
Конечный результат: 



 
 

Контрольные вопросы: 

1. Для чего нужны режимы наложения? 

2. Какие режимы наложения вы знаете? 

3. Перечислите особенности нескольких режимов (на выбор). 

4. Какие разновидности слоев вы знаете, и что они из себя 

представляют? 



 

Лабораторная работа №2 

Создание коллажа 

Цель: создать рекламный плакат  

Задача: изучить возможности цветокоррекции 

Краткие теоретические сведения 

Цветокоррекция — это изменение цветовых составляющих 

изображения (оттенка, тона, насыщенности и т.д.). Причин для 

цветокоррекции несколько: 

1. Иногда мы видим картинку с одними цветами, но на фотографии 

получаем совершенно другие. Это может произойти в силу неправильных 

настроек фотоаппарата (или по причине не качественности этого самого 

фотоаппарата :) ) или специфичности освещения (технические средства не 

способны адаптироваться к освещению, как это делает человеческий глаз, 

они лишь передают реальный цветовой спектр). 

2. Явные цветовые дефекты изображения. В таком случае 

цветокоррекция помогает справиться с засветами, слишком низким (или 

высоким) контрастом, дымкой, тусклостью цветов и т.д. 

3. Творческий замысел. Цветокоррекция играет на пользу 

художнику/фотографу/дизайнеру, добавляет выразительности изображению. 

Также сюда относится цветокоррекция отдельных элементов коллажа, дабы 

они начали казаться единым целым. 

Как правило, цветокоррекция в фотошопе производится с помощью 

разделения изображения на каналы. В зависимости от режима 

редактирования изображения выделяют: 

    Красный, Зеленый, Синий (Модель RGB — Red Green Blue). Самый 

популярный режим редактирования изображения. Именно с ним мы чаще 

всего и будем работать. 

    Голубой, Пурпурный, Жёлтый, Чёрный (Модель CMYK — Cyan 

Magenta Yellow blacK). 

Запомните, белый цвет в канале означает, что цвет этого канала 

присутствует в изображении в максимальном количестве. Чёрный — в 

минимальном. Например, если красный канал полностью чёрный, это значит, 

что красный цвет вовсе отсутствует в изображении. 

Фотошоп не даром считается мощнейшим инструментом для 

редактирования изображений. По сути, вся вкладка Image (Изображение) -> 

Adjustment (Коррекция) посвящена цветокоррекции изображения: 

Наиболее важными являются Levels (Уровни, горячая клавиша Ctrl+L), 

Curves (Кривые, горячая клавиша Ctrl+M), Selective Color (Выборочные 

цвета), Hue/Saturation (Цветовой тон/Насыщенность, горячая клавиша Ctrl+U)  

и Shadow/Highlights (Тень/Свет). 

  



Ход выполнения работы 

Сначала создайте новый документ Photoshop с размерами, как в 

скриншоте ниже. Для этого просто нажмите «CTRL+N» на клавиатуре или 

перейти на вкладку Файл и выберите новый. 

 
Вставьте ее в основной документ и разместите по центру полотна. 

 
Добавьте немного цвета бутылке. Для этого создайте новый слой (CTRL 

+ SHIFT + N) над слоем с бутылкой. Выберите на панели инструментов 

мягкую кисть Brush Tool (Кисть) с настройками как на скриншоте: 



 
Теперь, когда наша кисть настроена, мы можем раскрасить бутылку, 

начиная с ее верха. Вам не нужно создавать сложных форм, просто рисуйте, 

ориентируясь на линии бутылки. Цвет для рисования выберите насыщенный 

красный с несколькими быстрыми мазками желтого и оранжевого цвета. 

Ничего страшного, если мазки выходят за пределы бутылки. Мой результат 

ниже: 

 
Теперь мы можем применить размытие по Гауссу для плавного перехода 

оранжевого и желтого мазка в красный цвет: Filter (Фильтр) > Blur 

(Размытие) > Gaussian Blur (Размытие по Гауссу) с радиусом около 55-59. 



 
После применения фильтра мазки разного цвета плавно переходят друг в 

друга. 

 
Установите режим наложения для слоя с красными мазками Color (Цвет) 

100%. Это добавит немного цвета только средним тонам бутылки. Подробнее 

о том, что такое Режимы наложения (смешивания) слоев. 

http://takpro100.net.ua/beginer/178-blending.html


 
Теперь можно дублировать этот слой и установить режим смешивания 

дубликатов как Soft Light (Мягкий свет). Это должно создать более сильный 

контраст между оттенками и увеличить насыщенность цвета. Мой результат 

ниже. 



 
Если вам нравится, как выглядит ваша бутылка, вы можете остановиться 

на этом. А можно сделать дубликат слоя и инструментом перемещения (для 

его включения можно просто нажать клавишу V на клавиатуре) перетащить 

цветовой блик еще и на другую часть бутылки. 



 
Теперь нужно добавить в работу немного брызг воды для создания 

динамичного эффекта. Автор рекомендует использовать эту фотографию со 

стока. Если Вас это не устраивает, найдите другую, подходящую на ваш 

взгляд или воспользуйтесь клипартом Всплески и брызги. 

 

http://www.sxc.hu/browse.phtml?f=download&id=1180590
http://www.sxc.hu/browse.phtml?f=download&id=1180590
http://takpro100.net.ua/clipart/281-watersplash.html


Скопируйте это изображение в вашу работу, обесцветьте его – Image 

(Изображение) > Adjustment (Коррекция) > Desaturation (Обесцветить) и с 

помощью Image (Изображение) > Auto Levels (Автотон) (CTRL+SHIFT+L) 

сделайте небольшую коррекцию при помощи Image – Auto Levels 

(Изображение – Автотон) (CTRL+SHIFT+L). Изображение станет черно-

белым и автоматически подкорректируются настройки тона. 

(Если используете фотографию всплеска на белом фоне из коллекции на 

сайте, последовательность действий такая: добавить корректирующий слой 

Invert (Инвертировать) чтобы сделать фон черным, затем добавить 

корректирующий слой Black & White (Черно-Белый) чтобы обесцветить, 

щелкнуть кнопку Auto (Автотон) чтобы добавить контраста) 

Установите режим наложения для слоя с брызгами на Screen 

(Экранирование). Светлые и нейтральные тона изображения останутся 

видимыми, а все, что было черным, скроется. 

Теперь нужно передвинуть слой с брызгами с помощью инструмента 

Move Tool (Перемещение) так, чтобы брызги справа огибали бутылку. 

 
Лишнее нужно стереть. Используйте инструмент Eraser Tool (Ластик) 

(E). Для инструмента Eraser Tool (Ластик) нам нужна большая кисть средней 

жесткости. 

Сотрите все лишнее, оставьте только всплеск воды справа. 

Если добавить цвета нашему всплеску воды все будет намного 

эффектней! Откройте Hue/Saturation (Цветовой тон/Насыщенность), нажав 

CTRL+U. Задайте такие настройки: 



 
Результат - яркие цветные брызги: 

 
Если у Вас не получилось изменить цвет, посмотрите, не забыли 

поставить флажок Colorize? :) 

Вы можете добавить что-нибудь еще в Ваш документ. Автор 

использовал фотографию бокала мартини с фотостока iStock. Вы можете 

поискать похожее изображение на других или выбрать из этой коллекции 

клипарта. 

Так как у изображения с мартини фон черный, автор просто поместил 

его в работу и установил режим наложения Screen (Экранирование) так, как в 

слое с брызгами. Если в Вашем изображении другой цвет фона Вы можете 

http://takpro100.net.ua/clipart/282-bokal.html
http://takpro100.net.ua/clipart/282-bokal.html


использовать инструмент Magic Wand Tool (Волшебная палочка) для 

выделения и последующего удаления фона 

. 

 
После этого добавьте еще больше всплесков воды и брызг вокруг 

бутылки. Вы можете использовать стоковые изображения, ссылки на которые 

приведены у автора. Или использовать файл из того же клипарта Всплески и 

брызки, комбинируя всплески и изменяя их размер. Для создания интересных 

цветовых сочетаний используйте разные цветовые настройки для 

Hue/Saturation (Цветовой тон/Насыщенность) 

Мои результаты добавлений здесь: 



 

 
Этот шаг самый важный в создании атмосферы работы в целом, задает 

ей цветовые тона, основные в финальном варианте. Автор выбрал оттенки 



красного, синего и розового. Но вы можете использовать другие комбинации 

цвета на ваш вкус, важно, чтобы они хорошо сочетались друг с другом. 

Добавим в работу вишенку, можно использовать это 

изображение.Возьмите инструмент Magic Wand Tool (Волшебная палочка) 

(W). Кликните по белому фону вокруг вишенки для его выделения и нажмите 

Delete на клавиатуре. Это удалит белый фон вокруг вишни, если же какая-то 

часть фона останется, то возьмите инструмент Eraser Tool (Ластик) (E) и 

сотрите лишний фон. 

 
Переместите изображение с вишней в вашу работу , сделайте копию 

этого слой и задайте для копии режим наложения Overlay (Перекрытие). Это 

добавит контраста изображению вишни. 

Изменить размер вишни можно с помощью Free Transform (Свободная 

трансформация) (CTRL+T) и затем расположить ее в подходящем месте. 

Можно поместить вишню посередине всплеска брызг, чтобы создать 

иллюзию, что она плавает в воде. Слой с ягодой расположите между слоями 

с брызгами. 

http://takpro100.net.ua/images/stories/foto_obr/alcohol/Cherry.jpg
http://takpro100.net.ua/images/stories/foto_obr/alcohol/Cherry.jpg


 
Теперь вы можете продублировать несколько раз этот слой с вишней, 

затем инструментом перемещения перетяните ягоду в разные места вашей 

работы, внутри или снаружи всплесков воды. 

Добавим в работу остроты - изображение перца Чили. Можно 

использовать эту фотографию. Откройте ее, удалите фон и скопируйте какой-

нибудь перец в ваш рабочий документ. 

 

http://takpro100.net.ua/images/stories/foto_obr/alcohol/Three-Chilis.jpg


 
Точно так же добавьте клубнику 

 
Результат: 

http://takpro100.net.ua/images/stories/foto_obr/alcohol/strawberry.jpg


 
Контрольные вопросы 

 

1. Какие ошибки позволяет исправить цветокоррекция? 

2. Какие цветовые режимы вы знаете? 

3. Какие настройки применяются чаще всего для цветокоррекции 

изображения? 

 

Лабораторная работа №3 

Matte Painting 

Цель: создать сказочный остров на скале с помощью matte painting 

Краткие теоретические сведения 

Matte Painting - это крупномасштабные фотореалистичные изображения, 

которые используются для того, чтобы в кадре создавать иллюзии 

окружающей среды, поскольку часто натуральные съемки не могут создать 

нужного антуража, атмосферы. К тому же, работа с материальными 

декорациями, откровенно говоря, имеет меньше графических возможностей. 

Но все равно, именно с традиционных декораций  начался Matte Painting – его 



историю можно разделить на два периода: рисованный Matte Painting и 

цифровой. 

Началась история рисованного Matte Painting ещё в 1907 году с фильма 

«Калифорнийские Миссии» (The Missions of California). У оператора Нормана 

Доуна (Norman O. Dawn) возникла идея приукрасить здания – и это было 

сделано благодаря рисункам на стекле. Эти «декорации» заслоняли самые 

непривлекательные части здания. Такую методику назвали Glass Shot («кадр 

со стеклом»). Позже этот же оператор перестал рисовать на стекле – он 

использовал просто черную краску, а затем к делу приступали художники. 

Такой, кажущийся нам сейчас допотопным, способ использовался вплоть 

до середины 1980-х годов. Например, городские пейзажи из «Бегущий по 

лезвия бритвы» или бесконечные шахты «Звезды смерти» из «Звездных воин». 

Понятно, что создание и распространение компьютеров не могло не 

повлиять и на Matte Painting. Теперь компьютерные технологии пришли на 

помощь. В 1985 году в фильме «Молодой Шерлок Холмс» (Paramount 

Pictures), в сцене, где «оживает» изображение рыцаря на витраже, 

использовали компьютер. Витраж был нарисован художником, а затем его 

отсканировали и обработали в графическом редакторе. 

Цифровой Matte Painting начался с финальной сцены фильма «Крепкий 

орешек-2» — здесь были использованы натурные съемки и традиционный 

Matte Painting: сначала были отсняты созданные изображения, которые потом 

комбинировались на компьютере. 

Эра рисованного Matte Painting окончательно пришла к концу 

тысячелетия – в 1997 при съемках «Титаника» вручную был изготовлен 

спасательный корабль «Карпатия». 

На сегодняшний день Matte Painting – это практически исключительно 

использование редакторов компьютерной графики – трёхмерной и плоской. То 

есть это комбинация обработанных, дорисованных (часто до неузнаваемости) 

изображений. Для этого, конечно же, существуют даже отдельные 

программные пакеты. 



 

 



 
 

  



Ход выполнения работы 

Для начала создаем новый файл. Фон должен быть прозрачный. На него 

помещаем изображение города. Нижнюю часть выделяем с помощью 

прямоугольного выделения и удаляем ее. 

Открываем изображение с небом, выделяем там небольшой кусок неба и 

перемещаем его в наш файл. Располагаем поверх города, чтобы небо 

полностью его перекрывало. Берем ластик с параметрами жесткость 0, 

непрозрачность и нажим 100%.  Делаем видимым нижнюю часть картинки с 

городом, поменяв непрозрачность на 25%, делаем видимой башню. 

 
Открываем картинку со скалой, с помощью магнитного лассо выделяем 

нужную область и перемещаем ее в наш файл. Переворачиваем ее и 

подгоняем размеры с помощью свободного трансформирования. Слой со 

скалой должен быть ниже остальных. 

 
Выбираем полигональное лассо, выделяем часть, которую нужно 

удалить, чтобы скала стала треугольной. Удаляем выделенную область. 



 
Вызываем свободную трансформацию (Ctrl+T), правой кнопкой мыши 

вызываем меню, выбираем Деформацию. Изменяем скалу, как нужно. 

 
Изменяем прозрачность этого слоя до 90%.  И смягчаем края скалы с 

помощью ластика с параметрами жесткости 0, непрозрачности и нажима 

100%.  

 

 
Далее открываем изображение со скалистым берегом, также выделяем 

то, что нужно, и вставляем в картинку. Подгоняем размеры. Удаляем 



некоторые части скалы с помощью прямолинейного лассо, а края сглаживаем 

ластиком с параметрами жесткости 0, непрозрачность и нажим 100%. 

Заходим в Изображение – Коррекция – Цветовой тон/Насыщенность. Задаем 

параметры цветовой тон 0, насыщенность -35, яркость 0. Таким образом, 

делаем скалу менее яркой. 

 
Копируем этот слой (Ctrl+J), нажимаем Ctrl+T, правой кнопкой мыши 

вызываем меню и выбираем отобразить по горизонтали. 

 
Добавляем воду, располагаем этот слой ниже остальных слоев. С 

помощью мягкого ластика на слоях со скалами я доработала края. 



 
Создаем новый слой, размещаем его выше остальных. Выбираем Кисть 

и задаем для нее цвет 113639. Параметры кисти: жесткость 0, непрозрачность 

30, нажим 100.  

 
Проводим кистью по краям скал и воде, не затрагиваю скалу под 

островом. 

 



Создаем новый слой. Цвет кисти #25beb9. Параметры: жесткость 0, 

непрозрачность 15, нажим 100. Проводим ею по скале под островом. 

 
Создаем новый слой Цвет. Номер цвета 000228. Режим наложения - 

Исключение, непрозрачность 40.  

Еще один слой Цвет #2f6e89. Режим наложения – Перекрытие, 

непрозрачность 25. 

Еще один слой Кривые. Добавляем посередине кривой еще одну точку и 

указываем значения входа 133 и выхода 120. 

Еще один слой Цвет #b4f9ff. Режим наложения – Мягкий свет. 

Непрозрачность: 20 %. 

Последний слой Яркость/Контрастность. Параметры: яркость и контраст 

6.  

Нажимаем Shift+Ctrl+Alt+E, таким образом, объединяем все слои в один 

новый. 

Дублируем его. Для дубликата применяем размытие по Гауссу. У меня 4 

пикселя. Непрозрачность слоя 40%. Режим наложения Светлее. 

Объединяем два слоя (Ctrl+E). Применяем фильтр Умная резкозть с 

параметрами: настройки – по умолчанию, масштаб 125%, радиус 1 пиксель, 

удаление Размытие по Гауссу. 

 

 

 



 
Объединяем два слоя (Ctrl+E). Применяем фильтр Умная резкозть с 

параметрами: настройки – по умолчанию, масштаб 125%, радиус 1 пиксель, 

удаление Размытие по Гауссу. 

 

 
 

Контрольные вопросы 



1. Что такое matte painting? 

2. Какие возможности он дает? 

3. Назовите популярный пример использования matte painting  в 

киноиндустрии? 

 

Лабораторная работа №4 

Знакомство с инструментами ретуши 

Цель: отретушировать фото с помощью инструментов ретуши (Заплатка, 

Пластырь, Кисть и др.) 

Краткие теоретические сведения 

На панели инструментов инструменты ретуширования находятся в одной 

группе с инструментами рисования. Рассмотрим их.  

Восстанавливающая кисть - позволяет восстанавливать участки 

фотографий с помощью взятых за образец сохранившихся фрагментов. Она 

использует пикселы по образцу изображения или узора и сопоставляет их 

текстуру, освещение, прозрачность и затенение с соответствующими 

параметрами исправляемых пикселов. Так можно убирать родинки, прыщики, 

царапинки и другие дефекты.  

Точечная восстанавливающая кисть - позволяет абсолютно 

автоматически ретушировать некоторые недостатки фотографий. Действия 

точечной восстанавливающей кисти аналогичны действиям 

восстанавливающей кисти, но в отличие от нее не требуется указывать точку, 

которая используется в качестве образца. Точечная восстанавливающая кисть 

автоматически выбирает образцы пикселов из области вокруг ретушируемого 

фрагмента.  

Заплатка - позволяет восстанавливать выделенную область с помощью 

пикселов другой области (сочетание произвольного выделения и заливки). 

Заплатку можно поставить и в виде узора, если выбрать его на панели 

параметров в качестве источника.  

Красные глаза - удаляет эффект "красных глаз", а также белые и зеленые 

блики на фотографиях, снятых со вспышкой.  

Штамп - предназначен для нанесения одной части изображения поверх 

другой части изображения.  

Фоновый ластик - предназначен для отделения объекта от фона. Очень 

удобен для контрастных изображений.  

Волшебный ластик - гибрид "Ластика" и "Волшебной палочки". Главное 

отличие инструмента "Волшебный ластик", это скорость работы. Если с 

"Фоновым ластиком", нам приходилось водить курсором мыши для стирания 

фона, то в данном случае используется лишь щелчок. Стирает инструмент все 

пикселы,, цвет которых похож на цвет точки, по которой произведен щелчок, 

при этом существуют параметры, которыми можно ограничивать его работу. 

Этим инструментом можно сделать выбранный цвет пикселов частично 

прозрачными, задав числовое значение параметра прозрачность ниже ста 

процентов. Параметр "Допуск" задает диапазон цветов, входящих в спектр 

действия инструмента, чем выше числовое значение, тем больше цветов может 



стереть ластик. Чтобы удалить пикселы всего одного цвета, нужно задать 

числовое значение равное нулю.  

Поставьте флажок у "Сглаживание", чтобы сделать переходы между 

стертыми областями и целым изображением плавными. Поставьте флажок у 

"Смежные", чтобы в спектр действия входили только близкорасположенные 

точки. 

Ход выполнения работы 

С помощью инструментов панели ретуши необходимо убрать дефекты 

(родинки, морщины, неровный цвет лица и др.) со следующего портрета.   

 
Контрольные вопросы 

1. Какие инструменты относятся к панели Ретушь? 

2. Вкратце расскажите о возможностях каждого инструмента. 

Лабораторная работа №6 

Метод частотного разложения 

Цель: отретушировать портрет с помощью его разложения на частоты. 

Краткие теоретические сведения 

При обработке портрета часто возникает вопрос о том, как сохранить 

текстуру кожи, избавившись от всех неровностей и изъянов. Существует 

фильтр для Фотошопа Portraiture, который делает кожу пластиковой. Это не 

правильно. Сколько бы ни говорилось о том, что использовать его нужно 

умеренно, и дозировано, результат его применения оставляет желать 

лучшего. Мы сейчас поговорим о том, как достигнуть хорошего результата. 

Это способ не для ленивых. 



 
Частотное разложение - это метод ретуши, который известен уже 

давно. Все действия по разложению можно записать в экшен, и тогда процесс 

обработки максимально автоматизируется и упрощается.  

На чем основывается этот метод : он основывается на том, что любую 

картинку можно разложить на 2 составляющие – на верхние и нижние 

частоты (профессионалы пользуется разложением на верхние, средние и 

нижние частоты).  И если «сложить» их обратно – получим исходную 

картинку. Тем самым разделяем картинку на слой, который содержит 

текстуру кожи и слой, который содержит информацию о цвете, свето-

теневых переходах и "форме". Фильтр нижних частот в фотошопе – это 

фильтр Gaussian Blur. Верхних – High Pass, который необходимо применять 

через Внешний канал, т.к сам фильтр при "склеивании" дает неточности. 

Достоинства метода: простота в освоении даже для новичков, 

возможность временно усилить текстуру для ретуши путем простого 

отключения корректирующего слоя, снижающего контраст. 

Недостатки и ограничения метода разложения на две частоты: 

1. недостаточная гибкость, по сравнению с разложением 

изображения на три пространственных частоты, 

2. опасность появления артефактов на контрастных границах при 

работе на слое с текстурой, 

3. некоторая математическая неточность, обусловленная 

особенностью математики фильтра Цветовой контраст. 



Впрочем, надо отметить, что в 99% случаев этой погрешностью 

можно пренебречь, так как вы сами при ретуши вносите гораздо 

более существенные "погрешности", несоизмеримо большие. 

  



Ход выполнения работы 

Отретушировать следующий портрет с помощью метода частотного 

разложения. 

 
Контрольные вопросы 

1. Что такое метод частотного разложения? 

2. Что позволяет корректировать данный метод? 

3. В чем заключается работа метода разложения на частоты? 

4. Какие недостатки и достоинства этого метода вы знаете? 

5. Какие виды частотного разложения вы знаете? 

 

Лабораторная работа № 6 

Работа с примитивами 

Цель: создать картинку новогодних шаров с помощью примитивов и их 

настроек. 

Краткие теоретические сведения 

Примитивы - это прямоугольники и окружности, как и везде в любых 

других программах по работе с графикой. Служат они для составления более 

сложных частей. 

Как ни крути, примитивы основа всего. Что в 3D, что в 2D графике. 

 Откройте фотошоп и выберите первый примитив. Кликните по иконке и 

не отпускайте кнопку мышки. Вы увидите выпадающее меню с семью 

вложенными инструментами. Начнем с самого простого. 

Rectangle Tool — это самый обыкновенный прямоугольник. Просто 

выбирайте инструмент и рисуйте свой прямоугольник. В своих прошлых 

постах я уже говорил, что вектор в фотошопе не более чем векторная маска с 



заливкой. Прочитайте об этом подробнее в моей статье Shape Layer, Path и 

Fill Pixels в Фотошопе. Вся сакральность инструмента Rectangle Tool на этом 

заканчивается. Квадрат, он и в Африке квадрат. При этом, если вы хотите, 

чтобы примитив был определенного цвета, цвет стоит выставить заранее в 

меню Tools. Но если вы не выставили не беда, цвет всегда можно поправить в 

меню Options, которое выше. Конечно сам примитив для этого должен быть 

выделен в палитре слоев. 

Rounded Rectangle Tool — это обычный Rectangle Tool, но с 

закругленными краями. Радиус закругления краев регулируется из панели 

настроек векторных фигур Window > Options Соответственно, 5 px — это, не 

очень так закругленные углы. А вот 30 px — это очень даже сильно 

закругленные углы. Кроме пикселей можно писать любые принимаемые 

фотошопом размеры. Точки, миллиметры, сантиметры, дюймы и не только. 

Ellipse Tool — инструмент окружностей. Рисует он окружности. 

Эллипсы и круги. И это все, что делает инструмент Ellipse Tool. 

Polygonal Tool — рисует многогранники. От 3 до 100 углов. Впрочем, 

уже 20 углов сливаются, превращаясь в окружность. Настройка углов как 

обычно, в панели настроек. 

Line Tool — рисует линию. Я имею ввиду, он рисует очень тоненький 

прямоугольник, похожий на линию. В настройках регулируется ширина Line 

Tool от 1 до 1000 пикселей. Можно рисовать хоть квадраты. Выставил 100 

пикселей в ширину и отлично! 

Custom Shape Tool — не рисует вообще ничего. Custom Shape Tool 

штампует готовые, сохраненные фигуры. Все фигуры можно найти в 

менеджере фигур, который спрятан в настройках Custom Shape Tool. По 

умолчанию Custom Shape Tool имеет ряд своих стандартных фигур, и с 

десяток тематических коллекций. Сравнить Custom Shape Tool можно с 

символами в векторных программах.  

 

 

Настройки примитивов в Фотошопе 

Обратите внимание на меню настроек. Здесь вы видите те же самые 

инструменты, что и в меню Tools. Они полностью идентичны. 

Прямоугольник, закругленный прямоугольник, элипс, линия, многогранник. 

Интерес представляет небольшая выпадающая менюшка.  

    Square — эта функция автоматически соблюдает пропорции фигуры 

1:1. То есть рисуются идеальные круги и квадраты. Зажимать Shift не 

обязательно. 

    Fixed Sized — просто впишите нужные вам размеры и кликните по 

рабочей области один раз. У вас появится фигура с заданными параметрами. 

Вот он и фотошопный вариант иллюстратора. Верстать фигуры с 

определенными размерами не обязательно по линейке (Rulers). 

    Proportional — соблюдает пропорции. Например 2:1 

    Snap to pixels — а вот эту галочку я советовал бы всегда держать при 

себе. Дело в том, что векторный контур не связан с растром. Вектор имеет 



идеальную форму, строится по математическим формулам. Пиксель решает 

проблемы заливки вектора, за счет полузаливки. Если вектор проходит по 

середине пикселя, то фотошоп заливает эти пиксели на половину. 

  



Ход выполнения работы 

 
 

 

Шаг 1 

Создайте новый документ в Фотошопе размером 1000х1000 пикселей с 

разрешением 72 пиксель/дюйм. Создайте новый слой (Ctrl + Shift + Alt + N) и 

примените к нему стиль Gradient Overlay. 



 

 



 
Шаг 2 

Инструментом Ellipse Tool (U) создайте белый круг. 



 

 
Уменьшите его заливку до 20%. 



 
Создайте много копий круга и раскидайте их по всему правому краю 

холста. Используйте инструмент Free Transform (Ctrl + T) для изменения 

размера. 



 
Создайте ещё несколько кругов. Заливка написана на скриншоте. 



 
Добавьте ещё два круга. Цвет, режим наложения и заливка написаны на 

скриншоте. 



 
Объедините все круги в группу (Ctrl + G) и понизьте её заливку до 50%. 



 
Создайте копию группы и растрируйте её (Ctrl + E). К растрированному 

слою примените фильтр Gaussian Blur (Filter → Blur → Gaussian Blur). 

 



 
Инструментом Ellipse Tool (U) продолжайте создавать круги разного 

цвета. Используйте разную заливку для каждого круга. 



 
Создайте новый слой и выберите мягкую кисть. 

 
Обрисуйте круги цветом #FFE8A3. В нижней части непрозрачность 

кисти — 60%, в верхней — 30%. 



 
Шаг 3 

Создайте белый круг. 



 



 
Примените к нему следующие стили: 



 

 



 



 
Шаг 4 

Инструментом Rectangle Tool (U) создайте прямоугольник на шаре. 



 
Примените следующие стили: 



 

 



 
Шаг 5 

Сейчас мы нарисуем простой орнамент. Используйте инструменты 

Rectangle Tool (U) и Ellipse Tool (U), чтобы создать узор, показанный на 

скриншоте. Используйте функцию вычитания из области фигуры, чтобы 

быстрее создать полоски сверху и снизу. 

 
Примените следующие стили ко всем фигурам. 



 

 



 



 
Шаг 5 

Создайте белый овал. 



 
Добавьте к нему маску и выберите мягкую кисть с 60% 

непрозрачностью. 

 
Скройте овал чёрным цветом на маске, как показано ниже. 



 
Создайте новый слой и выберите мягкую кисть с 15% непрозрачностью. 

Нарисуйте белое пятно в центре белого овала. 



 
Шаг 6 

Создайте новый слой и выберите чёрную кисть с мягкими краями и 30% 

непрозрачностью. 



 
Нарисуйте тень под шаром. Расположите этот слой под слоями шара. 

 
Понизьте заливку слоя тени до 87%. 



 
Сейчас мы создадим ещё одну тень. Инструментом Ellipse Tool (U) 

создайте круг цветом #48090B. Этот слой должен над предыдущим слоем 

тени, но под слоями шара. 



 
Откройте окно Properties (Window → Properties) и увеличьте Feather до 

20 пикселей, чтобы смягчить края тени. 



 
Понизьте заливку слоя до 90%. 



 
Шаг 7 

Теперь создадим свечение от шара. Инструментом Ellipse Tool (U) 

создайте круг цветом #7E1414 под ним. Примените 20-пиксельную 

растушевку, как в предыдущем шаге. 



 
Понизьте заливку до 80% и установите режим наложения на Color. 



 
Шаг 8 

Объедините все слои шара в группу (Ctrl + G). Создайте копию группы, 

уменьшите её и расположите, как показано на скриншоте. Слои теней копии 

должны быть расположены под слоями первого шара. 



 
Шаг 9 

Инструментом Pen Tool (P) в режиме фигур нарисуйте нить, на которой 

будут висеть шары. 

 
На панели параметров инструмента введите следующие значения: 



 
Создайте копию нити и сдвиньте её на другой шар. 



 
Шаг 10 

Создайте корректирующий слой Curves через иконку чёрно-белого круга 

в нижней части палитры слоёв. 



 
Результат: 

 
Шаг 11 

Создайте новый слой и выберите мягкую кисть. 



 
Установите непрозрачность для кисти на 20% и нарисуйте свечение 

цветом #DDD900. 

 
Установите режим наложения на Overlay. 



 
Шаг 12 

Создайте ещё один корректирующий слой Curves. 

 



 
Шаг 13 

Создайте новый слой и выберите мягкую кисть с 30% непрозрачностью. 

 
Обрисуйте нити цветом #FFF690. 



 
Шаг 14 

Теперь займёмся золотыми звёздами. Выберите инструмент Custom 

Shape Tool (U) и выберите форму звезды. 

 
Создайте звезду, выберите инструмент Convert Point Tool и выделите 

внутренние якорные точки. Активируйте инструмент Free Transform (Ctrl + 

T), зажмите клавишу Alt и уменьшите звезду. Она должна изменить форму, 

как показано на скриншоте. Если сразу этого не получится, передвигайте 

каждую якорную точку по отдельности, пока не получите нужную форму. 



 
К слою звезды примените следующие стили: 

 



 

 



 
Шаг 15 

Выберите инструмент Pen Tool (P) и нарисуйте треугольник на звезде. 



 
Примените стиль Gradient Overlay: 



 

 



 
Создайте 4 копии треугольника и расположите их в других углах звезды. 

Для каждой копии измените угол градиента. 



 



 
Объедините все слои звезды в группу. Создайте несколько копий 

группы и расположите их в разных местах на холсте. 



 
Шаг 16 

Сейчас мы создадим свечение от звёзд. Выберите мягкую кисть с 20% 

непрозрачностью. 

 
Обрисуйте звёзды цветом #E2D400. 



 
Понизьте заливку слоя свечений до 50% и установите режим наложения 

на Pin Light. 

Контрольные вопросы 

1. Какие инструменты относятся к примитивам? 

2. С какими примитивами предпочтительнее работать: с 

векторными или растровыми? Почему? 

3. Какие настройки для примитивов существуют в Фотошоп? 

 

Лабораторная работа №7 

Обтравка объекта для предметной съемки 

Цель: научиться обтравлять предметы с фона. 

Краткие теоретические сведения 

Обтравка – это отделение предмета от фона изображения. 

Задача обтравки предметов с фона практически не отличается от обтравки 

людей. Сначала стандартно вырезаем объект на зеленом фоне. Во время 

удаления фона аккуратно сохраняйте очертания тени, чтобы они оставались 

полупрозрачными. При этом не забывайте про физические свойства самого 

предмета. Если на предмете есть полупрозрачные области - они должны 

оставаться полупрозрачными. Если на стекло попал жесткий блик, то в 90% 

случаев этот блик будет непрозрачным. 



Не забывайте про рефлексы от фона на предмете. Те области, на которые 

попадает зеленый цвет будут полупрозрачными. Убирать их сразу при работе 

экшена - плохая идея. Вы слишком завысите контраст, переходы прозрачности 

будут неестественными и, скорее всего, будут потери в детализации. Лучше 

оставьте области, на которые попадает зеленый засвет, серыми и почистите 

эти области вручную инструментами Dodge&Burn. 

 

Ход выполнения работы 

 
1. Конвертация 
2. Конвертируем фотографию, делая объект объемным. Сохраняем детали 

в тенях и не допускаем пересветов. ВАЖНО!  Получаем максимально 

"чистый зеленый фон" (либо синий, если объект снимался на синем фоне). При 

этом некоторые погрешности допустимы, если они не влияют на уровень 

детализации. Например, для зеленого фона цвет может быть R0 G210 B12. Или 

для синего R0 G17 B197. Но в идеале цвет фона, все же должен состоять только 

из одного канала. При необходимости, можно при конвертации немного 

понижать Luminance для цветовых диапазонов, близких к цвету фона. 

 



 
2. Обтравка объекта через Action 
После конвертации запускаем экшен "Chroma Key Extract". 

В диалоговом окне выбираем, в пункте Channel по-умолчанию выбран 

канал а, который соответствуем зеленому фону. Если фото снято на синем 

фоне - выберите канал b. Жмете ОК. 

Далее, мы поднимаем контраст полученной маски. В первый раз мы сдвигаем 

бегунки к краям гистограммы, тем самым растягивая гистограмму по всему 

яркостному диапазону и получая более детальную регулировку маски.

При появлении диалогового окна Levels во второй раз, нужно поднять яркость 

до 100% тех областей, которые гарантировано непрозрачные в реальной жизни 

и на которые не попал рефлекс от фона. Очень важно, чтобы черная точка не 



срезала часть диапазона, иначе вы рискуете потерять часть деталей теней.

 
Обратите внимание, те области на которые попадали засветы от зеленого фона 

я оставил серыми. Их нужно выводить в белый вручную. 

3. Чистка лишнего 

Берем инструменты Dodge&Burn и выжигаем в черный тен области фона, на 

которых нет тени от объекта, и выбеляем области на объекте, которые не 

являются прозрачными. 

Периодчески запускаем диалоговое окно Levels (Ctrl + L) и сдвигаем черную 

и белую точки, чтобы проверить какие области мы недочистили. Выглядит это 

примерно так: 



В итоге, наша маска будет иметь следующий вид: 



 
4. Перекрашивание рефлексов 

После того как мы почистили маску основного слоя, необходимо перекрасить 

цвет фона в цвет объекта. Для этого мы двойным кликом открываем Smart 

Object основного слоя и меняем hue в слое Hue/Saturation. По-умолчанию, 

Action создает слой Hue/Saturation, который перекрашивает зеленый диапазон 

цветов и оттенок. Эти значения можно использовать как отправную точку. 

Обратите внимание, что экшен перекрашивает только зеленый диапазон 

оттенков. Если объект снят на синем фоне, то вам нужно юудет вручную 

выставить диапазон перекрашиваемых оттенков и изменить им Hue.

 
 

5. Коррекция тени 
 



После всех манипуляций мы получили объект с полупрозрачной тенью. Но 

есть несколько нюансов: 

1. Тень выглядит неестественно на темных фонах 

2. На тени осталась текстура фона (тканевого или бумажного) 

3. У тени шумный, рваный край 

 



 
 

Наша задача сделать тень мягкой и хорошо выглядящей на любом фоне. 



Для этого вам требуется выбрать экшен "Chroma Key Extract Objects", 

скачать его можно по ссылке Media Actions 1,4 В первом диалоговом окне 

необходимо размыть фактуру фона. Подберите значения таким образом, 

чтобы граница с объектом была достаточно резкой, но текстура фона уже не 

читалась. 

 
 

В следующем диалоговом окне требуется размыть фактуру самого фона. 

Достаточно выставить те же значения, которыми вы размыли маску слоя. Если 

не размыть текстуру фона на основном слое, то она просто будет 

просвечиваться через маску. 

https://www.dropbox.com/s/q53ynn8pw12d919/Media%20Actions%201%2C4.atn


 
Теперь нам необходимо обесцветить и затемнить тень, чтобы она естественно 

смотрелась на темных фонах любого цвета. Для этого в новом диалоговом 

окне жуно задрать контраст маски, сдвинув белую точку так, чтобы белая 

область полностью покрывала область с тенью от объекта. Недольшие 

погрешности в виде градиентов - допустимы. 

Завершающим этапом появляется диалоговое окно, которое размоет края 

готовой маски. Выставьте значения Gaussian Blur не сильно большим, чтобы 



темные области объекта не сильно смешивались с областью тени, но 

достаточным, чтобы сделать края тени мягкими. 

 
После завершения работы экшена края тени останутся размытыми после 

Surface Blur'а и будет выбран инструмент History Brush. Этот инструмент, 

возвращает значения из определенного этапа истории редактирования файла.  

В нашем случае, он будет возвращать Gaussian Blur на те области маски 

основного слоя, по которой вы проведете кистью. Т.е. вам нужно пройтись 

кистью по края маски с тенью, чтобы сделать края менее рваными. 

В итоге мы имеем такую структуру файла: 

 
Замечания к редактированию: 

1) В случае появления темных контуров вокруг объекта - протрите черной 

кистью по корректировочному слою затемняющему тень; 

2) Чтобы сделать тень темнее или светлее - выберите маску основного слоя и 

вызовите меню Levels (Ctrl + L) и двигайте средний бегунок. 



  

Контрольные вопросы 

1. Почему предметы фотографируются предпочтительно на зеленом и 

синем фонах? 

2. Что такое обтравка? 

 

 

 

 


